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Preface

The RulePoint Getting Started Guide is written for RulePoint users. It provides a tutorial to help first-time
users to familiarize with various RulePoint tasks. The guide assumes that you are familiar with application
server and relational database concepts.

Informatica Resources

Informatica My Support Portal

As an Informatica customer, you can access the Informatica My Support Portal at
http://mysupport.informatica.com.

The site contains product information, user group information, newsletters, access to the Informatica
customer support case management system (ATLAS), the Informatica How-To Library, the Informatica
Knowledge Base, Informatica Product Documentation, and access to the Informatica user community.

Informatica Documentation

The Informatica Documentation team takes every effort to create accurate, usable documentation. If you
have questions, comments, or ideas about this documentation, contact the Informatica Documentation team
through email at infa_documentation@informatica.com. We will use your feedback to improve our
documentation. Let us know if we can contact you regarding your comments.

The Documentation team updates documentation as needed. To get the latest documentation for your
product, navigate to Product Documentation from http://mysupport.informatica.com.

Informatica Web Site

You can access the Informatica corporate web site at http://www.informatica.com. The site contains
information about Informatica, its background, upcoming events, and sales offices. You will also find product
and partner information. The services area of the site includes important information about technical
support, training and education, and implementation services.

Informatica How-To Library

As an Informatica customer, you can access the Informatica How-To Library at
http://mysupport.informatica.com. The How-To Library is a collection of resources to help you learn more
about Informatica products and features. It includes articles and interactive demonstrations that provide

solutions to common problems, compare features and behaviors, and guide you through performing specific
real-world tasks.

Informatica Knowledge Base

As an Informatica customer, you can access the Informatica Knowledge Base at
http://mysupport.informatica.com. Use the Knowledge Base to search for documented solutions to known
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technical issues about Informatica products. You can also find answers to frequently asked questions,
technical white papers, and technical tips. If you have questions, comments, or ideas about the Knowledge
Base, contact the Informatica Knowledge Base team through email at KB_Feedback@informatica.com.

Informatica Support YouTube Channel

You can access the Informatica Support YouTube channel at http://www.youtube.com/user/INFASupport.
The Informatica Support YouTube channel includes videos about solutions that guide you through performing
specific tasks. If you have questions, comments, or ideas about the Informatica Support YouTube channel,
contact the Support YouTube team through email at supportvideos@informatica.com or send a tweet to
@INFASupport.

Informatica Marketplace

The Informatica Marketplace is a forum where developers and partners can share solutions that augment,
extend, or enhance data integration implementations. By leveraging any of the hundreds of solutions
available on the Marketplace, you can improve your productivity and speed up time to implementation on
your projects. You can access Informatica Marketplace at http://www.informaticamarketplace.com.

Informatica Velocity

You can access Informatica Velocity at http://mysupport.informatica.com. Developed from the real-world
experience of hundreds of data management projects, Informatica Velocity represents the collective
knowledge of our consultants who have worked with organizations from around the world to plan, develop,
deploy, and maintain successful data management solutions. If you have questions, comments, or ideas
about Informatica Velocity, contact Informatica Professional Services at ips@informatica.com.

Informatica Global Customer Support

You can contact a Customer Support Center by telephone or through the Online Support.

Online Support requires a user name and password. You can request a user name and password at
http://mysupport.informatica.com.

The telephone numbers for Informatica Global Customer Support are available from the Informatica web site
at http://www.informatica.com/us/services-and-training/support-services/global-support-centers/.

Chapter 1: Preface
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CHAPTER 1

Introduction to RulePoint

This chapter includes the following topics:

e RulePoint Overview, 7

e RulePoint Architecture, 8

e RulePoint User Interface, 9

RulePoint Overview

RulePoint is a complex event processing (CEP) solution that delivers real-time operational business
intelligence within your enterprise. Business analysts can use RulePoint to maximize the efficiency of their
business processes, determine hidden patterns in data, and correlate real-time events that have a negative
impact on business.

How RulePoint Works

RulePoint uses services to collect information from streams of data flowing from different data sources.
Each unit of information is considered an event. RulePoint uses the business logic in rules to detect specific
events and respond to a user with specific information.

RulePoint consists of a design-time environment and a run-time environment. RulePoint design-time
environment comprises administrator tools and the infrastructure that is required to author objects, configure
and administer the run-time environment, and deploy objects from the design-time environment to the run-
time environment. The run-time environment provides the execution infrastructure that you need to deploy
and run rule processing objects.

You can scale the run-time environment across multiple nodes based on the volume and complexity of data
that you want to process. You can configure a primary and multiple backup run-time components to deliver

high availability to detect events, process rules, and dispatch alerts. If the primary run-time component fails,
the backup run-time component continues to process data.

You can also partition rules, sources, and responders across multiple nodes for efficient processing. For
example, you can deploy heavy load sources, custom services that are not thread safe, and rules associated
with high throughput and risk on select high-availability nodes.

RulePoint uses the asynchronous messaging model that is built into the Ultra Messaging Persistence (UMP)
product to move data between nodes.



RulePoint Example

You can use RulePoint in financial applications to detect events and monitor financial tasks.

You can configure rules to track streams of data for customer withdrawals that are beyond the required
minimum balance and alert the customer immediately. You can also configure rules to block the account and
simultaneously alert the customer when the account is accessed with incorrect passwords.

RulePoint provides extensive alerting capabilities through configured channels, such as email, instant
messages, or a web browser to individual users, groups, or external applications. Alerts allow the customer to
immediately respond and take action.

RulePoint Architecture

RulePoint consists of a distinct design-time environment and a run-time environment.

The following figure shows the RulePoint design-time and run-time environment:

Application User Interfaca
Clients
Host
MNode
- Source Responder Activity
Agglﬁi:;n Controller Event Processor Confroller Manager

Communications Layer
System UM lbmrd .
Services - UM Store Grid Manager

Host Agent

Design-time Environment

The RulePoint design-time environment comprises developer and administrator tools. You can use the
design-time user interface to create objects, configure and administer the run-time environment, and deploy
objects from the design-time environment to the run-time environment. The design-time environment is
packaged as a web application and runs in an Apache Tomcat web container.

You can create primary and secondary objects. Primary objects include sources, responders, and rules.
Supporting objects include topics, connections, responses, watchlists, and analytics.

Chapter 1: Introduction to RulePoint



Run-time Environment

The run-time environment consists of the topology, which provides the execution infrastructure for deploying
and processing rules and related objects.

The topology is a grouping of all the application services, system services, nodes, and hosts, along with the
entire configuration of RulePoint in the run-time environment. A default topology consists of a host, node,
application and system services. You can configure additional hosts, nodes, application services, and system
services in a default topology.

A topology consists of the following components:
Host

A machine where you install RulePoint. The default topology in RulePoint consists of the node and service
configurations on the host.

Node
A JVM process that hosts one or more application services.
Host Agent

A host agent runs on all the hosts in a topology and manages communication between the grid manager and
the node. A host agent collects statistics from the processes that run on its host and delivers the statistics to
the grid manager. The grid manager sends messages to the host agent based on the statistics it receives.
For example, the grid manager might send a message to kill or fork a process on the host.

Application Services

A service that runs on a node in the run-time environment. The RulePoint topology consists of application
services that generate and process events, evaluate events against rules, and record system activity.

Application services include the following services:

e Source controller. Generates events.

e Responder controller. Consumes event activations.

e Event processor. Consumes events, runs rules or template rules, and then generates event activations.
e Activity manager. Records and stores system activity for use in reporting.

System Services

A service that runs on the host in the run-time environment.

System services include the following services:

e Grid manager. Controls the life cycle and failover of all application services in the topology. The grid
manager manages deployment of objects into the application services and handles all interactions
between the design environment and the services.

¢ UM store. Enables guaranteed delivery for data exchange across all services within RulePoint.

e UM Ibmrd. Provides resolves address for data exchange across all services within RulePoint.

RulePoint User Interface

You can use the RulePoint user interface to create users and roles, create and deploy objects, and administer
RulePoint.

RulePoint User Interface 9



Design Tab

Use the Design tab to create objects and deploy them to the application services.

The Design tab contains views that correspond to a RulePoint object. A RulePoint installation includes a
default project and a default topic.

The following figure shows the All Objects view that lists the objects in a project:

informatica RulePoint Administrator | Heip | RTAM
Administration  Dashboard

ANObjects Sources Comections Topics Rules Templates Analytics Watchists Responses  Responders
Default Project > Objects ListView 1 Detalls View (@ Actions
Projects Actions. 1Objects

Defautt Project Name ~ Type ~ Last Modified Date + State~ Validity «

system_markers &, Topics 09/01/2014 10:54:17 P DRAFT () true

Filter By
Object Type  Sources v

Name
v

No tems

Administration Tab

Perform administrative tasks such as manage users, import and export objects, and manage a topology on
the Administration tab.

Use the User Management view, which is available on the Administration tab, to view default users and roles.
The following figure shows the User Management view, which lists the users created in RulePoint:

nformatica RulePoint 2 Administrator User Pre | Help | RTAM

Design Dashboard
UserManagement  Import  Export  Topology

Security > Users Actions

Actons Prieges

e ERoies !
Administrator

v

& Administrator ez
Usemame  Administrator
FistName  System
LastName  Administrator

Roles

Role Name. Description
ROLE_ADMIN Predefined Admin Role
ROLE_USER Predefined User Role
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Topology View
Use the Topology view to configure the RulePoint topology.

The RulePoint installer prompts you to create a default topology with a name of your choice. The default
topology contains the configuration details of the default host, node, application services, and system
services. To view the topology details, click the Topology view on the Administrator tab.

The following image shows the Topology view:

informatica RulePoint Q aministrator Help | RTAM

Design Dashboard
UserManagement  Import  Export  Topology

Topology : Default > Hosts List View Details View () Actions
& & Topology - Default 1 Hosts

HostIP Address Port Last Modified Date

10.65.142.173 19000 0910112014 10:49:22 PM

1}
% um Lomrd

Dashboard Tab

View application services, system services, nodes, and hosts in the topology on the Dashboard tab.

The components appear in green (running), or red (error) states. Pause on a component to view the name of
the component, type, and the status. When you select an application service, the nodes and host on which the
application service is located appears highlighted. The lower left panel displays the component details, and
the CPU and memory utilization for each configured host.

You can view the metrics of objects based on a time line on the right panel. When you select an application
service on the left panel, the right panel displays the deployed primary and supporting objects for that
application service. The lower right panel displays the activity, status, and a graph of the metrics of a
deployed object. You can also administer functions available on the lower-right pane for each object type.
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The following figure shows the Dashboard tab:

informatica RulePoint Administrator
Design  Administration |
Metrics Events  Logs
Selecttmeline:  SMnues  1SMinues  0Mnues  1Hour 3Hows  GHows  12Hous 24 Hours
Topology: Detault & @actions [N Fresponses @ Anaytes B, 3 watcnists
1 source 1 Event 1 Responder Rule Name Y Project Name Y sate Y Numberofactivations v
Controllers Processors Controllers 4
o Rulle {0 check for customers wih balance below 10000 Detaut Proect Startea 2
1 Activity Managers
1 Nodes 3 System Services
1 Hosts
1 1-10f1 ftems
Detault Event Processor atus of Rule: Rule to check for cu Actons
Host CRUMemory Us: " Aggregate Count Numor ofActvstons

Default Event Processor Rule to check for custome. 20

Event Processor Started "

H Running 20140207 1412 .

Defaut Node

10651244 s

o
2010207 13:12 20140207 20100207 1012
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CHAPTER 2

RulePoint Objects

This chapter includes the following topics:

e RulePoint Objects Overview, 13

e High-Level Workflow for Getting Started with RulePoint, 15

e Sample References, 17

RulePoint Objects Overview

RulePoint monitors events from sources and delivers responses when events match the rules. You configure
a function in RulePoint by creating a specific type of object that suits your requirements.

For example, you create a source to generate a specific set of events that interest you. You create topics to
group related events, and you create rules to evaluate those events. You also create responses to those
events, and you create responders to deliver the responses. After creating objects, you deploy them to the
run-time environment.

RulePoint objects are categorized as primary objects and supporting objects. Sources, responders, and rules
are primary objects. Topics, watchlists, analytics, templates (for template rule), connections, and responses
are supporting objects.

Primary objects drive the execution of the run-time components. Sources and responders are deployed in
their respective service controllers. Rules are deployed in the event processor.

The following table maps a primary object to the corresponding supporting objects:

Primary Objects Supporting Objects

Source Topic and Connection

Responder Response and Connection

Rule Topic, Analytic, Watchlist, Response, and Template (for template rule)
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The following table describes the primary and secondary RulePoint objects:

Object

Description

Topics

Topics categorize events and event properties, and provide a logical grouping for events originating
from multiple sources. When RulePoint receives an event, it identifies the properties and values of the
event and categorizes the event under a specific topic.

Connections

Connections connect RulePoint services to the target database. Multiple RulePoint service types can
share a single connection. You need to first create a connection and then map that connection to
various source objects.

Sources

Sources connect to external systems to fetch data, and then convert that data to events. The events
are published in topics. Before you create a source, create a topic and a connection for the source.

After you create a source, create a schedule to specify intervals at which the source must poll the

external sources for data that RulePoint can publish as events. You can configure the following types

of schedules:

- Configure a dynamic schedule if you want the source to wait for a configured period after
completing the previous task and before it begins publishing events again.

- Configure a static schedule if you want the source to publish events on a schedule that you set, such
as once every 30 minutes.

Responder

Responders dispatch alerts to external systems. When an event matches a rule condition, the event
processor creates a response, and the responder sends the response to the specified external system.

For a responder service and a particular type of response, you define the interface parameters. That is,
you specify the action that the responder must take when a rule is activated. From a single responder
service, you can create multiple specific responses.

Response

After you create a responder service, you must create a response. When a rule invokes that response,
the response implements the service with specific field values.

Watchlist

A watchlist is a container that stores a set of values as a single object to which you can assign a
unique name. You can reference the name in a rule so that the rule can use the data stored in the
object. You can modify the values in a watchlist at any time. Any rules that reference that watchlist use
the new values.

Analytic

An analytic implements a data processing function. Analytics provide simple functions, such as math,
text, and date functions, or more advanced functions, such as connecting to a remote server and
processing data before returning.

You can reference an analytic in a rule to check for various conditions, or manipulate the event data to
check specific conditions.
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Object Description

Template If you have experienced with rule syntax, create templates using DRQL. A template includes a rule
statement that contains substitution parameters and instructional text to define those parameters.
After you create a template, you can easily create new rules using the templates.

Rule You configure rules to identify specific events and respond to those events as they occur. For example,
you might want to configure a rule to listen to a news feed and send a specified user an email when the
headline of a news story contains "London."

You can either use the wizard, template, or advanced rule to create a rule. Configure the following rules

based on your requirement:

- Use the wizard rule, which is an easy-to-use interface that walks you through the process of
selecting topics, conditions, and responses while creating a rule.

- Use the advanced rule to create powerful rules that use the Detect and Respond Query Language
(DRQL) of RulePoint.

- Use the template rule if you are an inexperienced rule writer and want to create rules with minimal
errors. You can use the template rule for common scenarios, such as news event alerts, stock quote
price checks, and credit card transaction notifications.

For more information about configuring RulePoint objects and the predefined objects available in RulePoint,
see the RulePoint User Guide.

High-Level Workflow for Getting Started with
RulePoint

Use RulePoint to create, deploy, import, and export objects, configure the topology components, administer
RulePoint, and monitor the workflow progress.

Complete the following tasks to set up the RulePoint design-time and run-time environments:
Prerequisites

1. Install RulePoint.

2. Make sure that the license file is available in the following directory:
<RULEPOINT HOME>\conf\

3. Start the RulePoint server. To start the RulePoint server, you must start the host agent, the run-time
components, and the design-time components, in that order. Based on the operating system that you
use, perform the following tasks:

e |f you use a Linux operating system:

1. To start the host agent, navigate to the <RULEPOINT HOME>/bin/ directory, and then run the
following command:
startHostAgent.sh -h <host-name> -p <port-number>

2. To start the run-time components, in the <RULEPOINT HOME>/bin/ directory, run the following
command:
topology.sh start <TOPOLOGY NAME>
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3. To start the design-time environment, in the <RULEPOINT HOME>/bin/ directory, run the following
command:
design.sh run

e If you use a Windows operating system:

1. To start the host agent, navigate to the <RULEPOINT HOME>\bin\ directory, and then run the
following command:
startHostAgent.bat -h <ip address> -p <port-number>

2. To start the run-time components, in the <RULEPOINT HOME>\bin\ directory, run the following
command:
topology.bat start <TOPOLOGY NAME>

3. To start the design-time environment, in the <RULEPOINT HOME>\bin\ directory, run the following
command:
design.bat run

To run the design.bat file in a new command window, type design.bat start.

The default topology, which consists of a single-node environment, is up and running.

Procedure

1.

To log in to the RulePoint server, type the following URL in the address bar of your browser: http://
<FQDN:port number>/rulepoint.Log into RulePoint by using the default credentials, Administrator/
Administrator1.

(Optional) Create a role with specific permissions, create a user, and then associate a user with that role.
You can log in to RulePoint with those user credentials and create objects.

Create a project.
Create primary and secondary objects for the project, as follows:

a. Create atopic to group a particular event, and add the properties that you want to associate with the
topic.

b. Create a connection with properties suited to the source or responder types that you want to create.
c. Create a RulePoint source to fetch data from an external source.

d. Create a static or dynamic schedule to specify the interval at which the RulePoint source must poll
the external data source for data that can be published as events.

e. Create a responder to dispatch alerts to external systems.
f.  Create a response, and associate the response with the responder service.

g. Create rules by using either the wizard rule, template rule, or the advanced rule. You can create the
following objects to reference them in rules:

e (Optional) An analytic, to include math, text, and date functions, or other advanced functions.
e (Optional) A watchlist, to include a list of values to monitor.

Deploy the source, rule, and responder from the design-time environment to the source controller, the
event processor, and the responder controller, respectively. You can deploy a single object or multiple
objects at a time.

Note: You can redeploy, undeploy, or reassign deployed objects.

(Optional) You can export or import an object as an XML file, to and from a project, respectively. If you
import an XML file, RulePoint uses the XML file to process events and generate alerts.
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7. (Optional) If you want to set up a high-availability environment for the event processor, source controller,
and responder controller, perform the following tasks:

a. Create additional hosts in the topology.

Note: Before you configure a new host in the topology, shut down the runtime, design time, and host
agent. Copy the RulePoint installation folder to the host that you want to configure. Set the
environmental variable RULEPOINT_HOME on the host to the installation folder and start the host
agent on the host.

b. Create additional nodes.
c. Select each of the run-time components and set the deployment mode to high availability.
d. Assign the run-time components to specific nodes based on your requirements.

e. Based on how you want to distribute the objects across the instances, you can reassign deployed
rules, sources, and responders to the event processor and service controller instances, respectively.

Note: You must shut down the run-time environment before you start the configuration. After you
complete configuring the components, you must start the run-time environment so that the
configurations apply.

8. (Optional) View the dashboard to see how the objects are processed at run time. Use the functions on
the dashboard to manage the objects.

Note: You can view the configured application services on the dashboard only when the run time is up
and running.

Sample References

The use cases help you understand the workflow for processing RulePoint objects. The samples help you
understand how to use RulePoint to retrieve information from a source, process the information, and notify
you with the appropriate alerts.

For more information, see the following documents:
Banking Use Case Tutorial

Represents the RulePoint processing flow using data that simulates a banking database and provides
solutions for banking requirements. The tutorial helps you understand the RulePoint functionalities. You
learn how to create RulePoint objects, deploy the objects, and receive appropriate alerts. You learn to
configure custom services in RulePoint and use the REST APIs taking the banking use case as an
example.

Trading Use Case Example
Presents trading use cases that you can solve using RulePoint.
Business Process Management Example

Presents common loan processing scenarios solved using RulePoint.
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